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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Introduction

Draw est un outil de dessin vectoriel, qui peut également effectuer des opérations sur des images 
matricielles (pixels). Avec Draw, vous pouvez réaliser rapidement une grande variété d'images 
graphiques.

Un outil de dessin vectoriel permet de stocker et d'afficher un graphique en tant qu'ensemble 
d'éléments géométriques simples, comme des lignes, des cercles et des polygones, plutôt qu'un 
ensemble de pixels (éléments d'images ou points à l'écran). Ceci permet un stockage plus simple 
et un dimensionnement plus précis des éléments du graphique.

Draw est complètement intégré à la suite LibreOffice, ce qui permet de simplifier les échanges de 
dessins vectoriels avec tous les composants de la suite. Par exemple, si vous créez un dessin 
dans Draw et que vous voulez l'utiliser dans un document Writer, il vous suffit de le copier et de le 
coller. Vous pouvez également travailler sur des dessins directement dans Writer ou dans Impress 
en utilisant un sous-ensemble de fonctions et d'outils de Draw.

Les fonctionnalités de Draw sont très complètes et, bien qu'il n'ait pas été conçu pour rivaliser avec
des applications graphiques spécialisées, il possède néanmoins plus de fonctions que les outils de
dessin habituellement intégrés dans les suites bureautiques.

On peut citer de manière non exhaustive parmi les fonctions de dessin la gestion de couches, un 
système complet de points magnétiques, le tracé de cotations associatives, des connecteurs 
facilitant la réalisation d'organigrammes, des fonctions 3D permettant de réaliser de petits dessins 
tridimensionnels (avec entre autres la gestion des textures et des éclairages), l'intégration de 
styles de dessin et de pages et le tracé de courbes de Bézier.

Ce Guide Draw n'est pas un cours que vous devez parcourir du début à la fin. Il s'agit surtout d'un 
ouvrage de référence que vous pouvez parcourir pour une aide sur des points particuliers.

Ce document ne décrit que les fonctions associées à Draw. Certains concepts, comme la gestion 
de fichiers ou l'environnement de travail de LibreOffice, ne sont mentionnés que brièvement. Ils 
sont couverts plus en détail dans le Guide du Débutant.

Espace de travail

Les principaux composants de l'espace de travail de Draw sont indiqués Figure 1.

La grande zone au centre de la fenêtre est l'endroit où vous faites vos dessins. Vous pouvez 
disposer autour de cette zone de dessin des barres d'outils et des zones d'information. Le nombre 
et la position des outils visibles varient selon la tâche en cours et les préférences de l'utilisateur. 
Par conséquent, votre disposition peut être différente. Par exemple, certains utilisateurs disposent 
la barre d'outils Dessin sur le côté gauche de l'espace de travail et non en bas comme Figure 1.

Vous pouvez répartir les dessins de Draw sur plusieurs pages. Les dessins multi-pages sont 
principalement utilisés pour les présentations. Le volet Pages, du côté gauche de l'espace de 
travail de Draw dans la Figure 1, vous donne une vue générale des pages que vous avez créées. 
Si le volet Pages n'est pas visible, vous pouvez l'activer avec la commande Affichage > Volet 
page de la barre de menus. Pour modifier l'ordre des pages, cliquez et faites glisser les pages que
vous souhaitez.

Dans LibreOffice Draw, la taille maximum d'une page est de 300 x 300 cm.
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Figure 1 : Espace de travail Draw

Règles
Vous pouvez voir les règles (des barres avec des nombres) en haut et à gauche de la zone de 
dessin de Draw. Si elles ne sont pas visibles, vous pouvez les activer en sélectionnant Affichage >
Règle depuis la barre de menus.

Les règles montrent la taille de l'objet sélectionné sur la page au moyen de lignes doubles 
(entourées en rouge dans la Figure 2). Elles montrent également avec des lignes simples 
(entourées en vert dans la Figure 2) la position du curseur de la souris, ce qui aide à positionner 
les objets de dessin plus précisément.

Vous pouvez également utiliser les règles pour manipuler les poignées des objets et les lignes de 
capture. Vous pouvez ainsi cliquer et faire glisser une ligne double pour modifier la taille de l'objet 
sélectionné.

Les marges de la page sont indiquées par une zone grisée à l'intérieur des règles. Vous pouvez 
modifier les marges directement dans les règles en les cliquant et les faisant glisser avec la souris.

La position par défaut du zéro pour chacune des règles est située dans le coin supérieur gauche 
de la page, après les marges gauche et supérieure (voir Figure 2). Cette position du zéro peut être
modifiée en cliquant sur l'endroit où les règles horizontale et verticale se rejoignent ( ) et en 
faisant glisser jusqu'à la position désirée.
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Figure 2 : Règles

Pour modifier l'unité de mesure, faites un clic droit sur la règle désirée, comme Figure 3. Vous 
pouvez modifier les unités de mesure de chacune des règles indépendamment l'une de l'autre.

Figure 3 : Unités de mesure
des règles

Grille et guides de dessin
Draw dispose d'une grille et de lignes de capture pour assister le dessin. Elles peuvent être 

activées et désactivées en cliquant sur les boutons Afficher la grille  et Afficher les lignes de 

capture  de la barre d'outils Options. Les points de la grille et les lignes de capture sont affichés
uniquement à l'écran et ne sont pas imprimés, ni visibles quand le dessin est utilisé dans un autre 
composant de LibreOffice. La couleur, la résolution et la finesse de la grille de points peuvent être 
individualisées pour chaque axe. Ceci est détaillé dans le Chapitre 3 (Manipuler les objets et les 
points des objets).

Des lignes d'aide lors du déplacement peuvent être activées ou désactivées en cliquant sur le 

bouton Lignes d'aide lors du déplacement  de la barre d'outils Options. Elles permettent de 
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positionner l'objet plus facilement. Lorsque cette fonction est active, des paires de lignes 
horizontales et verticales entourant l'objet sont affichées durant son déplacement. Ces lignes 
s'étendent jusqu'aux côtés de la zone de dessin. Cette fonction est également décrite Chapitre 3 
(Manipuler les objets et les points des objets).

Draw dispose d'autres fonctions qui vous permettent de positionner les objets dans un document, 
fonctions décrites Chapitre 3 (Manipuler les objets et les points des objets).

Barre d'état
La barre d'état est située au bas de la fenêtre Draw et comprend plusieurs zones (Figure 4).

Figure 4 : Barre d'état Draw

• La zone d'information montre quelle action est en cours, ou quel type d'objet est 
sélectionné.

• La position et la taille d'objet affichent des informations différentes selon le fait que des 
objets soient sélectionnés ou non.

– Si aucun objet n'est sélectionné, les nombres de la position indiquent la position 
actuelle (coordonnées X et Y) du curseur de la souris.

– Si un objet est sélectionné, les nombres de la position indiquent les coordonnées X et Y du 
coin supérieur gauche de l'objet et les nombres de la taille indiquent sa largeur et sa 
hauteur.

– Si plusieurs objets sont sélectionnés, les nombres de la position indiquent les 
coordonnées X et Y du coin supérieur gauche et les nombres de la taille indiquent la 
taille du plus petit rectangle possible contenant l'ensemble des objets sélectionnés. 
Voir Chapitre 3 (Manipuler les objets et les points des objets) pour plus d'informations.

– Si un ou plusieurs objets sont sélectionnés et en cours de modification de position ou 
de taille, les données s'actualisent au fur et à mesure du déplacement ou du 
redimensionnement.

– Si un ou plusieurs objets sont sélectionnés, un double clic sur l'une ou l'autre de ces 
informations ouvre la boîte de dialogue Position et taille. Voir Chapitre 4 (Modifier les 
attributs des objets) pour plus d'informations.

Note
Les nombres des positions et tailles sont exprimés dans l'unité de mesure en cours 
définie dans Outils > Options > LibreOffice Draw > Général, et non dans l'unité de 
mesure définie pour la règle.
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• L'icône Modifications non enregistrées ( ) apparaît ici si des changements dans le 
document n'ont pas été enregistrés. Double-cliquez sur cette icône pour enregistrer le 
document.

• L'icône Signature numérique ( ) indique si le document a été signé numériquement ou 
non. Un double clic ou un clic droit sur cette zone permet d'ouvrir la boîte de dialogue 
Signatures numériques. Il est nécessaire d'avoir enregistré au moins une fois un document 
avant de pouvoir le signer.

• Le numéro de diapositive indique le numéro de séquence de la page de dessin en cours 
et le nombre total de pages du document. Si un objet est sélectionné, le nom de la couche 
dans laquelle se trouve l'objet est indiqué entre parenthèses.

• Le style de page indique quel style de diapo est utilisé. Un clic droit sur cette zone permet 
de choisir parmi les styles de diapo définis. Un double clic permet d'ouvrir la boîte de 
dialogue Style de diapo.

• Le curseur de zoom permet de modifier le grossissement de l'affichage en glissant le 
curseur sur la gauche ou la droite ou en cliquant sur les signes + et -.

• Le pourcentage de zoom affiche le niveau de zoom sous forme de pourcentage. Vous 
pouvez faire un clic droit sur ce pourcentage pour sélectionner une valeur de 
grossissement ou double-cliquer pour ouvrir la boîte de dialogue Zoom & disposition des 
pages. Voir Chapitre 3 (Manipuler les objets et les points des objets) pour plus 
d'informations.

Barres d'outils

Figure 5 : Sélection des boutons visibles d'une barre d'outils
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Vous pouvez afficher ou masquer les différentes barres d'outils de Draw selon vos besoins. Pour 
afficher ou masquer une barre d'outils, allez dans Affichage > Barres d'outils. Les barres d'outils 
visibles ont une coche devant leur nom dans le menu qui apparaît. Choisissez celles que vous 
voulez afficher.

Vous pouvez également sélectionner les icônes ou boutons que vous voulez voir apparaître dans 
les barres d'outils. Pour ceci, faites un clic droit sur la barre d'outils et choisissez Boutons visibles
dans le menu contextuel. Les icônes ou boutons visibles sont dans un cadre. Dans l'exemple de la
Figure 5, tous les boutons sont visibles, sauf Image Map, Retourner et Position et taille. Cliquez 
sur une icône pour l'afficher ou la masquer dans la barre d'outils.

Barre d'outils Standard
La barre d'outils Standard (Figure 6) est la même pour tous les composants de LibreOffice et n'est 
pas décrite en détail dans ce chapitre.

Figure 6 : Barre d'outils Standard

Barre d'outils Dessin
La barre d'outils Dessin (Figure 7) est la barre d'outils la plus importante dans Draw. Elle contient 
toutes les fonctions nécessaires pour dessiner différentes formes géométriques et à main levée et 
les organiser dans le document. Elle est décrite en détail dans le Chapitre 2 (Dessiner des formes 
élémentaires).

Figure 7 : Barre d'outils Dessin

Barre d'outils Ligne et remplissage
La barre d'outils Ligne et remplissage (Figure 8) vous permet de modifier les propriétés d'un objet 
de dessin. Les boutons et les listes déroulantes varient selon le type d'objet sélectionné. Par 
exemple, pour modifier le style d'une ligne, cliquez sur les flèches vers le haut et vers le bas de 
Style de ligne et choisissez le style voulu.

Les fonctions disponibles dans la barre d'outils Ligne et remplissage vous permettent de modifier 
la couleur, le style et la largeur d'une ligne dessinée, ainsi que la couleur de remplissage, le style 
et d'autres propriétés d'un objet. L'objet doit avoir préalablement été sélectionné par un clic de 
souris. Si l'objet sélectionné est un cadre de texte, c'est la barre d'outils Formatage du texte 
(Figure 9) qui s'affiche.

Figure 8 : Barre d'outils Ligne et remplissage
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Barre d'outils Formatage du texte
La barre d'outils Formatage du texte (Figure 9) ressemble beaucoup à la barre d'outils Formatage 
de Writer. Une explication plus détaillée des fonctions de cette barre d'outils se trouve dans le 
Chapitre 4 (Modifier les attributs d'un objet). Pour plus d'informations sur l'ajout et le formatage des
textes, voir Chapitre 9 (Ajouter et formater un texte).

Figure 9 : Barre d'outils Formatage du texte

Barre d'outils Options
La barre d'outils Options (Figure 10) vous permet d'activer et de désactiver différentes aides au 
dessin. Cette barre d'outils n'est pas affichée par défaut ; pour le faire, allez dans Affichage > 
Barre d'outils > Options. Les options sont listées dans la Figure 11 et sont décrites plus en détail 
dans d'autres chapitres de ce guide.

Figure 10 : Barre d'outils Options

Figure 11 : Outils disponibles dans la 
barre d'outils Options

Faire flotter et déplacer les barres d'outils
Les barres d'outils sont ancrables. Vous pouvez les déplacer, changer leurs dimensions ou les 
ancrer à un côté.

Pour ancrer une barre d'outils à un côté, faites-la glisser jusqu'à ce qu'un rectangle grisé 
matérialisant sa future position apparaisse. Pour ancrer une barre d'outils à sa dernière position, 
affichez son menu en effectuant un clic droit sur la barre, puis choisissez Ancrer la barre d'outils. 
Pour supprimer l'ancrage, déplacez la barre à l'aide de la poignée située à sa gauche (Figure 12).
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Figure 12 : Poignées des barres d'outils

Vous pouvez également ancrer ou détacher une barre d'outils en maintenant appuyée la touche 
Ctrl et en double-cliquant dans la barre ailleurs que sur un outil.

Plusieurs icônes ont un petit triangle noir pointant vers le bas de leur côté droit. Ceci indique que 
cette icône comprend plusieurs outils disponibles. Cliquez sur le triangle pour afficher l'ensemble 
complet d'outils (Figure 13). Vous pouvez détacher cet ensemble d'outils pour qu'il devienne une 
barre d'outils flottante. Cliquez sur la zone avec des lignes parallèles en bas de l'ensemble d'outils 
(entourée en rouge Figure 13), faites-le glisser à l'endroit de l'écran que vous désirez et relâchez le
bouton de la souris.

Pour ancrer une barre d'outils flottante, vous pouvez double-cliquer dans sa barre de titres ou faire
un clic droit et choisir Ancrer la barre d'outils dans le menu contextuel. Pour fermer une barre 
d'outils flottante, cliquez sur la croix en haut à droite.

Figure 13 : Détacher et faire flotter une barre d'outils

Note

L'icône de ces ensembles d'outils est celle qui correspond au dernier outil que vous 
avez utilisé, ce qui explique que vous pouvez voir à l'écran autre chose que ce que 
vous voyez dans les figures de ce guide. Elle reste en place même une fois la barre 
d'outils détachée.

Personnaliser les barres d'outils
Vous pouvez personnaliser les barres d'outils de différentes manières. Pour afficher ou masquer 
les boutons d'une barre d'outils, voir Figure 5 page 9.

Pour ajouter des fonctions à une barre d'outils, déplacer des outils entre barres d'outils ou créer de
nouvelles barres d'outils, choisissez Affichage > Barre d'outils > Personnaliser, puis l'onglet 
Barres d'outils (Figure 14). Sélectionnez la barre d'outils dans la liste déroulante. Vous pouvez 
alors gérer son contenu. Voir le Guide du Débutant pour plus d'informations.
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Figure 14 : Personnaliser les barres d'outils

Choisir et définir des couleurs

Barre de couleurs
La barre de couleurs (Figure 15) affiche les couleurs de la palette en cours. Elle vous permet de 
sélectionner rapidement la couleur de différents objets (lignes, zones et effets 3D) de votre 
document. La première case du panneau correspond à invisible (pas de couleur). Si la barre de 
couleurs n'apparaît pas, sélectionnez Affichage > Barres d'outils > Barre de couleurs.

Figure 15 : Barre de couleurs

Choisir une palette de couleurs
Vous pouvez accéder à plusieurs palettes de couleurs spécialisées dans Draw. Vous pouvez 
également modifier les couleurs individuelles selon votre goût. Ceci s'effectue dans la boîte de 
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dialogue Remplissage (Figure 16), qui apparaît en choisissant Format > Remplissage depuis la 

barre de menus ou en cliquant sur l'icône Remplissage  de la barre d'outils Ligne et 
remplissage. Dans cette boîte de dialogue, cliquez sur l'onglet Couleurs.

Figure 16 : Modifier la palette de couleurs

Pour charger une autre palette, cliquez sur le bouton Charger la liste des couleurs . La boîte
de dialogue de sélection de fichiers vous demande de choisir l'une des palettes standard de 
LibreOffice (fichiers avec extension *.soc). Par exemple, web.soc est une palette de couleurs 
adaptée pour créer des dessins à placer dans des pages web. Ces couleurs s'afficheront 
correctement sur les écrans capables d'afficher au moins 256 couleurs.

Une description plus détaillée des couleurs et de leurs options figure dans le Chapitre 10 
(Techniques avancées de Draw).

Impression rapide

Cliquez sur l'icône Impression rapide  pour envoyer le document entier à l'imprimante par 
défaut définie pour votre ordinateur.

Note

Vous pouvez changer l'action de l'icône Impression rapide pour envoyer le 
document à une imprimante définie pour le document au lieu de l'imprimante par 
défaut de l'ordinateur. Choisissez Outils > Options > Chargement/ 
enregistrement > Général et cochez Charger les paramètres d'impression avec 
le document (comportement par défaut). Le choix d'une imprimante spécifique 
pour un document se fait par Fichier > Paramétrage de l'imprimante.
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Contrôler l'impression

Pour mieux contrôler l'impression, utilisez la boîte de dialogue Imprimer (Fichier > Imprimer ou 
Ctrl+P). Cette boîte de dialogue (Figure 17) comporte quatre onglets, dans lesquels vous pouvez 
choisir une variété d'options, comme décrit dans les sections suivantes.

Figure 17 : Boîte de dialogue Imprimer

Sélectionner les options d'impression générales
Dans l'onglet Général de la boîte de dialogue Imprimer (Figure 17), vous pouvez choisir :

• l'imprimante (parmi les imprimantes disponibles)

• quelles pages imprimer, le nombre d'exemplaires, s'il faut assembler les exemplaires 
multiples et s'il faut imprimer dans l'ordre inverse des pages

Sélectionnez le bouton Propriétés pour afficher une boîte de dialogue spécifique à l'imprimante où
vous pouvez choisir parmi les options offertes par le pilote : filigranes, recto-verso, qualité 
d'impression, etc.

Pour n'imprimer que certaines pages, séparez les numéros par des points virgules. Pour imprimer 
une plage de pages, insérez un trait d’union entre le premier et le dernier numéro de pages. Vous 
pouvez combiner des plages de pages et des pages uniques. Par exemple : 1-3 ; 6 ; 8-9 
imprimera toutes les pages de 1 à 9 sauf les pages 4, 5 et 7. Vous pouvez également sélectionner 
dans le document les pages que vous voulez imprimer et cocher Sélection.

Options d'impression
Dans l'onglet Options de la boîte de dialogue Imprimer (Figure 18), vous pouvez choisir d'imprimer 
dans un fichier (et non vers une imprimante), de créer un seul travail d'impression comprenant les 
multiples exemplaires du document (et non un travail d'impression pour chaque copie) et d'utiliser 
uniquement le bac d'alimentation à partir des préférences de l'imprimante.
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Figure 18 : Boîte de dialogue Options d'impression

Imprimer plusieurs pages sur une seule feuille de papier
Vous pouvez imprimer plusieurs pages sur une seule feuille de papier. Pour ceci :

1) Dans la boîte de dialogue Imprimer, sélectionnez l'onglet Mise en page (Figure 19).

Figure 19 : Imprimer plusieurs pages par feuille de papier

2) Dans la section Mise en page, sélectionnez dans la liste déroulante le nombre de pages à 
imprimer par feuille de papier. L'aperçu sur la droite de cette liste vous montre 
l'organisation des pages au sein du document imprimé.

Si vous imprimez plus de deux pages par feuille de papier, vous pouvez choisir l'ordre dans
lequel elles seront imprimées horizontalement et verticalement dans la feuille de papier. 
Les images de la Figure 19 et de la Figure 20 vous montrent la différence.

Figure 20 : Imprimer plusieurs pages par feuille de papier

3) Vous pouvez choisir de dessiner une bordure autour de chaque page ou non.

4) Cliquez sur le bouton Imprimer.

Imprimer une brochure
Dans Writer, Impress et Draw, vous pouvez imprimer un document sous forme de brochure. Draw 
imprime alors deux pages sur chaque côté de la feuille de façon à ce que le document puisse être 
lu comme une livre une fois le papier plié.
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Astuce
Planifiez votre document pour qu'il apparaisse correctement quand il sera imprimé 
à la moitié de sa taille : choisissez des marges et des tailles de police appropriées, 
entre autres. Vous aurez peut-être besoin de faire plusieurs tentatives.

Imprimante recto uniquement
Pour imprimer une brochure avec une imprimante sur une seule face :

1) Choisissez Fichier > Imprimer et, dans la boîte de dialogue Imprimer et l'onglet Général, 
cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue Propriétés de votre 
imprimante. Cette boîte de dialogue varie selon le modèle de l'imprimante.

2) Vérifiez que l'orientation de l'imprimante (portrait ou paysage) est la même que celle de 
votre document. Habituellement, cela n'a pas d'importance, mais c'est nécessaire pour 
imprimer une brochure.

3) Validez si nécessaire et revenez à la boîte de dialogue Imprimer.

4) Choisissez l'onglet Mise en page (Figure 19).

5) Cochez l'option Brochure. Dans la section Côtés des pages, choisissez Verso / pages de 
gauche dans la liste déroulante (Figure 21).

Figure 21 : Imprimer une brochure

6) Cliquez sur le bouton Imprimer.

7) Retirez les pages imprimées de l'imprimante, retournez-les et remettez-les dans 
l'imprimante dans le bon sens pour imprimer sur la face vierge. Vous aurez peut-être 
besoin de faire plusieurs tentatives.

8) Choisissez Fichier > Imprimer et, dans la boîte de dialogue, dans la section Côtés des 
pages, choisissez Recto / pages de droite dans la liste déroulante.

9) Cliquez sur le bouton Imprimer.

Imprimante recto-verso
Pour imprimer une brochure avec une imprimante recto-verso :

1) Choisissez Fichier > Imprimer et, dans la boîte de dialogue Imprimer et l'onglet Général, 
cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue Propriétés de votre 
imprimante. Cette boîte de dialogue varie selon le modèle de l'imprimante.

2) Vérifiez que l'orientation de l'imprimante (portrait ou paysage) est la même que celle de 
votre document. Habituellement, cela n'a pas d'importance, mais c'est nécessaire pour 
imprimer une brochure.

3) Ajustez les paramètres d'impression recto-verso selon les caractéristiques de l'imprimante.

4) Validez si nécessaire et revenez à la boîte de dialogue Imprimer.

5) Choisissez l'onglet Mise en page (Figure 19).

6) Cochez l'option Brochure. Dans la section Côtés des pages, choisissez Toutes les pages 
dans la liste déroulante (Figure 21).

7) Cliquez sur le bouton Imprimer.
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Imprimer en noir et blanc ou en niveau de gris
Vous pouvez vouloir imprimer votre document en noir et blanc ou en niveaux de gris sur une 
imprimante couleur. Vous pouvez le faire à différents niveaux.

Pour modifier les paramètres au niveau de l'imprimante :

1) Choisissez Fichier > Imprimer et, dans la boîte de dialogue Imprimer et l'onglet Général, 
cliquez sur le bouton Propriétés pour ouvrir la boîte de dialogue Propriétés de votre 
imprimante. Cette boîte de dialogue varie selon le modèle de l'imprimante.

2) Choisissez les paramètres d'impression noir et blanc ou niveaux de gris propres à votre 
imprimante. Cliquez sur OK pour valider.

3) Cliquez sur le bouton Imprimer.

Pour modifier les paramètres d'impression au niveau de LibreOffice :

1) Choisissez Outils > Options > LibreOffice > Impression.

2) Cochez l'option Convertir les couleurs en niveaux de gris. Cliquez sur OK pour garder les 
modifications.

3) Imprimez le document.

Pour modifier les paramètres d'impression au niveau de Draw :

1) Choisissez Outils > Options > LibreOffice Draw > Impression.

2) Dans la section Qualité, cochez Niveaux de gris ou Noir et blanc. Cliquez sur OK pour 
garder les modifications.

3) Imprimez le document.

Exporter en PDF

LibreOffice peut exporter les documents au format PDF (Portable Document Format). Ce format de
fichier standard est idéal pour envoyer un fichier à une autre personne qui utilise Adobe Reader ou
un autre lecteur PDF. La procédure et les boîtes de dialogue sont les mêmes pour Writer, Calc, 
Impress et Draw.

Export rapide au format PDF

Cliquez sur l'icône Export direct au format PDF  pour exporter le document entier en utilisant 
les paramétrages PDF par défaut. Vous devrez entrer le nom et l'emplacement du fichier PDF, 
mais vous ne pourrez pas choisir les pages à imprimer, un taux de compression des images ou 
d'autres options.

Contrôler le contenu et la qualité du fichier PDF
Pour mieux contrôler le contenu et la qualité du fichier PDF résultant, utilisez Fichier > Exporter 
au format PDF. La boîte de dialogue Options PDF s'ouvre. Cette boîte de dialogue comporte cinq 
onglets (Général, Vue initiale, Interface utilisateur, Liens et Sécurité). Effectuez les paramétrages 
appropriés, puis cliquez sur Exporter. Vous devrez alors saisir l'emplacement et le nom du fichier 
PDF à créer et cliquer sur Exporter pour exporter le fichier. Voir le Guide du Débutant pour plus 
d'informations.
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Exporter dans d'autres formats

LibreOffice utilise le terme "export" pour des opérations sur les fichiers qui impliquent un 
changement de type de fichier. Si vous ne trouvez pas ce que vous voulez dans Fichier > 
Enregistrer sous, regardez dans Fichier > Exporter. LibreOffice peut exporter des fichiers dans 
les différents formats qui sont mentionnés dans la liste déroulante. Voir Chapitre 6 (Éditer des 
images) pour plus d'informations sur l'export des éléments graphiques.

Pour exporter un fichier dans un autre format :

1) Remplissez le nom de fichier du document exporté dans le champ Nom de fichier.

2) Choisissez le format voulu dans la liste déroulante Format de fichier.

3) Cliquez sur le bouton Exporter.

Note

Le contenu du fichier exporté peut dépendre du ou des éléments sélectionnés 
dans la page. Avec la plupart des formats d'images, seule l'image de la page en 
cours sera exportée. Le dialogue comporte une case à cocher Sélection qui 
détermine si l'export porte uniquement sur les objets graphiques sélectionnés. Si 
cette case n'est pas cochée, la totalité du document est exportée.

Exporter des documents Draw en tant que pages web

Pour exporter un document Draw multi-pages en une série de pages web, choisissez Fichier > 
Exporter, puis sélectionnez Document HTML en tant que type de fichier. L'assistant Export HTML 
s'ouvre. Suivez-le pour créer des pages web. Si vous le souhaitez, l'assistant peut générer une 
aide à la navigation pour vous aider à vous déplacer de page en page.

Envoyer des documents par e-mail

LibreOffice fournit plusieurs façons rapides et faciles pour envoyer des classeurs en tant que 
pièces jointes d'un e-mail, et ce dans le format OpenDocument (format par défaut de LibreOffice) 
ou PDF.

Note
Les documents ne peuvent être envoyés depuis le menu de LibreOffice que si un 
profil mail a été paramétré sur votre système.

Pour envoyer le document en cours dans le format OpenDocument :

1) Choisissez Fichier > Envoyer > Document par e-mail. LibreOffice ouvre votre client de 
messagerie par défaut avec le document Draw (*.ODG) en tant que pièce jointe.

2) Dans votre client de messagerie, entrez le destinataire, l'objet et tout texte que vous voulez
ajouter, puis envoyez l'e-mail.

Si vous choisissez Envoyer par e-mail en PDF, LibreOffice va tout d'abord créer un fichier au 
format PDF en utilisant les paramètres PDF par défaut (tels que si vous utilisiez le bouton de barre
d'outils Export direct au format PDF), puis va ouvrir votre client de messagerie avec en pièce 
jointe le fichier *.PDF.

Vous pouvez envoyer un document par e-mail à plusieurs destinataires en utilisant les 
fonctionnalités de votre client de messagerie ou les fonctions de l'Assistant mailing de LibreOffice 
Writer pour extraire des adresses mail d'un carnet d'adresses.

Pour plus de détails, voir Chapitre 10 (Imprimer, exporter et envoyer par e-mail) du Guide du 
débutant.
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